FISH-quant: tutorials

In this tutorial we explain the basic workflow of the analysis of FISH images in FISH-quant based
on the example data-set. You can familiarize yourself with the main functionality of FISH-quant
by following this tutorial. We will refer several times specifically to the example data-set and
invite the user to change different parameters and investigate the effect on the analysis. These
examples are indicated with boxes like the following:

Example: load image BGH_CY3_03.tif

We provide screen-shot of the most important steps explained. For advanced features and more
details please consult the detailed user manual.

The example data and a more detailed user manual can be downloaded from
http://code.google.com/p/fish-quant/.
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1. Getting started

1.1. Install FISH-quant for Matlab
Install FISH-quant on the computer and setup Matlab to use it.

1.

Download FISH-quant. Source code is provided as zip-archive on the website
(http://code.google.com/p/fish-quant/). Copy this file to your computer.

Find user folder of Matlab . Will be used to copy the unzipped source-code. You can find this
folder by opening Matlab and typing userpath in the command window.
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Extract FISH-quant archive to this folder. You can then extract the zip archive of FISH-quant
to this folder.

Update path definition in Matlab. This step is very important since it will tell Matlab
where to find the source code of FISH-quant.

a. Inthe Matlab menu select File > Set Path

b. This will open a dialog box. In this box select Add with subfolders ...

c. This will open another dialog. Here select the folder of FISH_QUANT from step 3, e.g.
/Users/fmueller/Documents/Matlab. Click OK. The respective folders will be
added (see screenshot below).

d. To save this settings press Save. Depending on the settings of the installation of Matlab
this might results in a warning saying that the changes to path cannot be saved. Matlab
proposes to save the path-definition file pathdef.m to another location. Click Yes. Select a
directory of choice, e.g. the Matlab work directory of the user.



800 Set Path

All changes take effect immediately.
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5. FISH-quant can then be started by typing FQ in the command window and pressing enter.

1.2. Typical files produced in FISH-quant - overview of example data set

The example data is again provided as a zip archive. It contains the typical files and folders that
are generated during the analysis with FISH-QUANT. In this folder you can find the file
__FISH_QUANT _Test_data.pdf containing a detailed description of all provided data.

The results of the different analysis steps performed FISH-quant can be saved in different sub-
folders. While these sub-folders are optional, we recommend using them since they help to keep
the data organized. Several different folders can be used:

* Images. Here the FISH and DAPI images are stored. You can also save the filtered FISH
images that would (FISH and DAPI), outlines (to define where the cells are in the images),
and results (mature and nascent mRNA counting) are used.

* Outlines. Contains text files that contain the outlines of the individual cells in the images and
well as the position of transcription sites and (optional) nuclei in these cells. The files also
contain general information about the experimental settings and the images they are defined
for.

* Results. Separate folders for the results of the mature mRNA detection and the transcription
site quantification. The results file for the mature mRNA detection contain all the outlines,
together with detailed information about each detected spots. Further they also contain the
name of the images they were defined for. Different subfolders could also be generated to
test different settings.

1.3. Define a folder-structure for your project

As described before you can use multiple folders for the results generated in FISH-quant. The
files describing outlines and results of mRNA detection contain information about the images
they are defined for. HOWEVER, they do NOT contain information about the folders where these
images can be found. These folders have to be manually defined in FISH-quant. This allows
moving the files to other locations without having wrong references to folders in the files.



In FISH-quant you can define the different folders from the menu Folders. First you can define a
root folder which will serve a starting folder for all the other folder explained above. For each
folder a dialog box will open that will allow specifying the different folders.
.H 0O FISH-QUANT v2a: main interface
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Here you can either specify the folders of the example data or define the folders for the new

project you want to work on. For the latter, we recommend generating the folders suggested
above. This can be done in any file manager, e.g. Explorer under Windows or Finder under Mac.

1.4. Inspect example data

After defining the folders for the example data, you can play around with these files to get a first
feeling for how FISH-quant works.

First, you have to define the folders.

1. Setroot folder.

2. Set folder for images, outlines, and results (results_mature).
Things to do

* Open one of the outlines files and check out the outline-designer. For this go to [FQ] Main >
Load > Cell outline. This will then open a dialog box and show the content of the outline
folder. Select one of the files. FISH-quant will then open the associated image file and display
the outline file. To change this outline, e.g. add or delete a cell, click on ‘Define outlines’. This
will open a new interface where the outlines can be changed.

* Open one of the mRNA detection files. For this go to [FQ] Main > Load > Results of spot
detection. Here the folder with the results will be shown. Again select a file. FISH-quant will
display the image, the outlines of the cells, and also all the detected spots. Now also the
histograms in the lower part are populated. Here the fitted parameters of the 3D Gaussian fit
are displayed for the currently selected cell (another cell can be selected in the pull-down
menu next to the ‘Define outlines’ button). Changing the allowed range for the parameters
will remove more or less spots. The detected spots can also be inspected in more detail in
the spot inspector that can be launched by pressing on the ‘Visualize spots’ button.

The displayed results are also only for the currently selected cell. If multiple cells are defined
for this image, they can be selected in the respective pull-down menu.
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2. Defining outline files

One of the central text files in FISH-quant are the outline files. These files specify for each FISH
image where the cells and their associated transcription sites and (optional) nucleus are in the
images. The file also contains a reference to the FISH image it is associated to. FISH-quant allows
loading (and associating) additional image files to an outline file

i. DAPIimage: can be used to automatically detect the nucleus
ii. Image with an independent label of the transcription sites. Can be used to automatically

detect transcription sites (explained below).

In the example data, three outlines files have been defined for the three images. They can be
found in the outlines folder.

Defining the nuclei is not necessary for the analysis in FISH-quant. It can be useful to for the
automated detection of transcription sites and determine the number of transcripts in the
cytoplasm vs. the nucleus.

Usually outlines for all cells are defined before proceeding with the analysis.

Example: the sub-folder outlines contains the outline files for three example images.

2.1. Define outlines

1. Define folders (at least root folder, and folders for images and outlines).

2. Define experimental parameters. Press ‘Modify’ to change a @ O  Experimenta. .
number of basic parameters. This has to be done ONLY once in an | Pisetsizexyinm)
analysis session. FISH-quant will remember them for the ™
subsequently opened images.

Pixel-size 2 [nm]
| 600

The plot on the right shows the parameters for the example data. Refractiveindex

1.458

| Numneric aperture N&,
| 125

Emnission wavelength
568

Excitation wavelength
| 568 |

Microscope
widefiekd

OK Cancel

3. Open image. This can be done either from the menu [FQ] Main > Load > Image [Raw] or by
pressing on the button ‘Load image’. Click OK in the dialog that opens to confirm that the
analysis results will be deleted.

Example: load image BGH_CY3_03.tif. This is stacked .tif file of mRNA FISH with two cells.

4. Press button ‘Define outlines’ to open separate user interface that allows defining outlines of
cell and transcription sites (see below with a description of the basic controls). With these
controls you can change the contrast, zoom, pan, and also switch from a view of the
maximum intensity projection to a view of the individual z-slices.
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5. Then you can define outlines. A typical workflow encompasses:

a.

Load DAPI image from the menu: Load images > Load DAPI. Image will be shown as an
overlay with the FISH image. Either both or only one of the image can be selected
(bottom left corner). Contrast of either image can be changed (controls under the plot).
Last, image can be inspected as a maximum intensity projection in xy or by navigating
the different z-slices (Navigate 3D stack).

Then you can define the outlines of the different cells. You can also choose the geometry
of regions you want to use: polygons, ellipse, or rectangle. To draw a new cell press ‘New
cell’, move over the image and wait until the cursor turns into a cross; draw the region;
to finish double-click (for polygon on the first point). Region will then be shown with a
solid green line. You can then modify this region, or delete it if you are not satisfied.

For each cell you can then define transcription sites and (optional) a nucleus. First, select
the cell where you want to draw these outlines and then draw them as you did for cells.
Both elements have to be within the cell, otherwise they will be rejected.

Example:

Load image BGH_DAPI_03.tif. Change contrast of each image to optimize display. You can
also toggle the display of the either image.

Then use the polygon tool to outline the two cells and their nuclei, and the rectangle
selection to outline the two transcription sites.

6. Press Finished to return to main interface. Save outline from the menu [FQ Main] > Save >
Outline of cells.

To define outlines in a lot of different cells two different methods can be used

ii.

Open each of the images in the main interface and perform the steps describe above.

Open the Outline definer from the tools menu in the main interface of FISH-quant. This
will open the same interface as described above. However, now you can load the images




from the menu Load images > FISH. Then you can define the outlines as describe and
save them with [FQ] outline > Save outline. Each time you load a new FISH image, the
defined outlines will be deleted.

Important: when working with this option, define first the experimental parameters and
the folder structure in the main interface. These settings will then be used in the Outline
definer.

2.2. [Optional] Automatic detection of nuclei

Nuclei can be defined manually as described before or automatically based on a nuclear stain
such as DAPI. Here FISH-quant proposes a threshold value (between 0 and 100). Press ‘Detect
nucleus’ to perform detection with a given value. Nuclei will then be automatically. Depending
on the signal this might not work for all cells, and the outlines of these cells have to be defined
manually.

Example: for BGH_CY3_03.tif a value of 2.2 gives a good detection. Smaller values are not
stringent enough and the two nuclei will not be separated. Larger values will be too stringent
and the detected nuclei will be too small.

2.3. [Optional] Automatic detection of transcription sites

Transcription sites (TS) can be defined either manually or detected automatically. FISH-quant
provides two different methods. In both approaches the detection is based on a minimum
intensity threshold a TS has to have. In the first approach the FISH image is used directly, in the
second approach an image with an independent label for the TS is used, i.e. Lacl. For more
details see the supplementary material (Note 4.4) of the Nature methods paper.

1. Load outline file or define cells in image. TS are only defined for the cells that are outlined,
without cell no TS will be identified.

2. Optional: define parameters for TS detection from the menu Options > TxSite detection. The
default parameters work often fine. Consult the FISH-quant user manual for a detailed
description.

3. Define intensity threshold that separates transcription site from mature mRNA. This can be
either done on the FISH image (select FISH_image in the pull-down menu) or on an image
with a label for the TS (Select TS_label). This image can be loaded from the menu Load
images > Load TS-label.

You can get a feeling for the values by selecting the Cursor tool in the lower part of the
interface. When clicking on different parts of the image, a window will display the position of
the cursor as well as the intensity of the FISH image and the second displayed image (either
TS label or DAPI). Set the threshold value in the field next to Threshold [TS].

Press TS auto-detect to perform the detection. TS will only be detected in the defined cells. If
the threshold is too low, then too many TS are detected. By default the detection stops when
more than 100 TS are detected. Also the maximum number of TS per cells can be defined (by
default 4). This can be changed in the options.

4. [Optional] Restrict detection to nucleus. To avoid over-detection, the detection can be
restricted to the nucleus. Here two different methods can be defined.

* Ifnuclei are defined, then the option ‘Only in nucleus’ will restrict the TS to these defined
nucleus. For cells where no nucleus is defined, then the entire cell will be considered.

* Define intensity threshold for DAPI signal. Rather than defining the nucleus, an
additional intensity threshold for the DAPI signal can be set. This usually works well




since the DAPI signal is substantially brighter in the nucleus. Simply define this value in
the field next to Threshold [DAPI].

Example: TS auto-detect

For BGH_CY3_03.tif a intensity threshold of 700 for the TS, and 1000

FISH_image [
for the DAPI gave good results. -
Threshold [TS) 700
Threshold [DAPI) 1000

™ only in nucleus

The TS detection settings can also be saved and can be used in the batch mode for an
automated TS detection. Menu [FQ] Outline > Save settings for TS detection.



3. Mature mRNA counting

After the outlines are defined for all cells, the detection of mature mRNA can be performed. This
analysis is one of the central parts of FISH-quant and it is necessary to understand the different
parameters to optimize the detection. We therefore explain the different involved steps in detail
below.

The mRNA counting will be done for the cells defined in the outline files. In the example data, the
mature mRNA detection has been performed for the three outlines files and can be found in the
folder results_ mature. Here files summarizing the settings, and a results file for each of the
outline files is saved.

The overall workflow can be split in two parts as also described below:

1. Define the detection settings for one cell (preferably with a lot of mRNA) and save the
settings. This can be done on several cells to check that the settings are the same for each
cell. If this is the case these settings can be used for a batch analysis.

2. The settings can then be used in a batch-processing module and applied to all cells. The final
thresholding can then be done based on all detected spots in all images.

The mRNA detection itself involves two major steps

1. Pre-detection of spot candidates (mRNA) on filtered image.

2. Fit spot candidates with 3D Gaussian. This will be done on the raw image. Provides the
position of each spot with high precision. Additional thresholding can be performed to
separate true spots from noise.

3.1. Mature mRNA detection on individual images
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1.

2.

Continue from steps before or open FISH-quant, define folders, and open one already defined
outline. Set the results folder as well (we usually recommend a separate folder for the results
of the mature mRNA detection).

Filter image

We use a two-step filtering. First, the image is blurred with a Gaussian filter with a large
kernel. This image is a good approximation of the background and is subtracted from the
original image. The resulting image is then filtered with a small Gaussian kernel to increase
the signal-to-noise ratio (SNR). The size of this filter is expressed in a multiplicative factor
for the theoretical size of the point-spread-function (PSF). The important thing here is that
the resulting image has little background and bright, localized spots. By default the size for
the large kernel (for the background) is set to 5, the size for the small kernel (for the
increase of the SNR) to 1.

The filtered image can also be saved from the menu [FQ] Main > Save > Filtered image. It
will be save in the defined folder for images. If you save the outline file now, a reference to
this filtered image will be saved and the filtering step has not be done again. If the analysis is
performed in the batch-mode (below) filtered images are generated and new outlines files
saved that contain a reference to these images.

Tip: When you double-click on the image (after selecting Select plot
filtered image, and disabling ‘Outline) you can open the image in Filtered image :

the Image Tool of Matlab. This allows inspecting the image by
zooming, changing the contract, ....

’Tl __ Outline
See Matlab help for ‘Interactive 220 : manefiool?icimaspial
Exploration with the Image Tool‘ for il e, =

. » @00 7?7 8o RIAQAM i 200% v
more details.

When moving with the cursor over
the image Matlab displays the
location and intensity of the pixel
over which the cursor is currently
located in the lower left corner
(Pixel info).

Pixelinfo: (118, 97) 34 Display range: [0 193]

Example: the default Kernel size works well for the test data. Change these values to explore
their impact on the filtered image.

Perform pre-detection

The pre-detection will be performed for the currently selected cell in a separate interface.
These settings will then be applied to all cells in the image.

Before opening this interface, FISH-quant will test a range of threshold values and determine
the number of detected spots for each tested value (explained in more detail below). This
range has, however, to be adapted to your image data. The crucial parameter to set is the
maximum intensity value that will be tested. To get this value we usually inspect the filtered
image with the ‘Image Tool’ of Matlab (see above). By moving over the individual spots, you
can get a first feeling for their brightness and determine what range the brightest ones have.
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You can start the pre-detection by pressing ‘Detect’. This will open a separate interface
where the different parameters can be defined, before the interface is shown, a user dialog is
displayed that allows specifying this range (below).

By default FISH-quant tests 50 values between 5 and
150. Here the maximum value can then be adjusted s
(to around 1.5-2 times the intensity of the brightest
spot).

™ O O Parameters to calculate pre-detection thresholds

Minirmurm intensitythreshold to test

Maximumn intensitythreshold to test
150

Nurnber of intensity values to test
50

oK Cancel

FISH-quant will then perform the pre-initialization (see also workspace for progress) and
show the pre-detection interface. Depending on the size of the image this can take a few
seconds. A number of important settings are defined in this interface:

Size of the detection region around each detected spots. A region of this size will then be

cropped and used to fit the 3D Gaussian. Spots are by default NOT considered if such a
region can’t be extracted (because they are too close to the edge). This region is
calculated based on the theoretical size of the PSF. Usually these values are ok but they
can be adjusted in case they are too small (not enough of the signal is considered) or too
large (too much background is considered and/or a lot of spots are rejected because they
are too close to the border of the image).

Intensity threshold for the pre-detection. This is the minimum value a spot must have in

the filtered image to be considered. FISH-quant shows a plot that help to select this
threshold. The plot in the panel [1/2] (see below) shows the number of detected spots as
a function of the used intensity threshold. For a low intensity threshold too many spots
are detected, for a high threshold only a few spots are detected. For the range that
corresponds to the individual spots a plateau is usually visible. Place the threshold
towards the left side of this plateau (A value of 19 for the plot below).
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By pressing ‘Analyze’ the selected threshold value will be applied. FISH-quant will then
display an image that shows the results of this detection for the selected cell.

e 0o Figure 4

This  plot displays the "G i View imsert Toos Deskion “Window Help
detected spots in maximum - ide b W09 d- 2 0E
intensity projections in XY
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Al detected spots

Al detected spots
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The second row shows spots
that are away from the edge, oty e 5005 eyt ine
i.e. the detection region can X
be cropped around them. The
third row shows spots that
are away from transcription
sites.

You can zoom-in the different plots. The three plots in a column are connected, so if you
change the zoom in one of them, the others will be updated. This guarantees that always
the same field of view is displayed. These plots can already give an indication if a good
threshold was chosen. FISH-quant provides two different pre-detection methods, they
usually provide similar results (see manual for more detail).

Example: a value of 19 gives good results. A smaller value leads to over-detection, a
much larger value to under-detection.

Optionally an additional quality score can be determined. Here two different methods
are implemented (i) standard deviation of all pixel intensities in the cropped area
around each spot (ii) 3D curvature. The latter is especially suited for brighter FISH data.
Either metric gives larger values for bright spots which are usually individual mRNA. An
additional threshold can then be defined for this quality score.

Depending on the quality of the image and how well the pre-detection worked, this
threshold might not be necessary. We usually recommend setting the pre-detection
threshold in a way that false-positives are already avoided as much as possible. If
necessary, the quality score can then used as well. A final thresholding can then be
performed based on the fits with the 3D Gaussian (below).

Example:

With a detection threshold of 19 mainly good spots are detected (around 100 mRNAs for
Cell_2). The quality score histogram shows one broadened peak that starts at around 5
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(for the standard deviation).

Histogram of quality score of all candidates
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Decreasing the detection threshold to 5 leads to a massive over-detection (around 400
mRNAs). However, these false-positives have a smaller quality score. By setting the
threshold for the quality score to 5, most of them are rejected (only 108 mRNAs pass this
test).

Histogram of quality score of all candidates
25 0 T T T T T T T

Counts

S ) e o 1 1 1
20 25 30 35 40 45
Quality score

Similar results can be achieved with the quality score based on the curvature. Here the
difference in the histograms is even larger.

* To apply the setting to all cells in the image press ‘Apply detection to all cells in the
image’. The interface will then close and the pre-detection be performed. Depending on
the number of cell in the image, this can take a few minutes. A status update is provided
in the Matlab command window.

4. Fit detected spots with 3D Gaussian.

The detected spots are then fit with a 3D Gaussian. This is performed on the raw image since
filtering affects the intensity in a non-trivial way and also affects the localization precision.

On computers with multiple cores this analysis can be performed with parallel computing
(requires the Matlab Parallel Computing toolbox). This option can be enabled by enabling
the option ‘Parallel computing’. This takes a few moments, so please wait until the status
update indicates that the activation is completed.

To start the fitting press ‘Fit’. Depending on the number of detected spots this can take a few
minutes. Updates are provided in the Matlab command window. When the fit is then a
number of windows will be populated in the lower part of the main interface.

The panel wit the label ‘7. Thresholding’ allows to inspect the different (fitting) parameters
that were estimated for each spot. They can be used to further exclude spots that are false-
positives and are background. The relevant parameters here are the size of the spot in XY
(‘Sigma-XY’), the size in Z (‘Sigma Z’), and the amplitude (‘Amplitude’). Background spots
have usually large sigma’s and small amplitudes. To exclude them, the user can define for
each parameter upper and lower boundaries.
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a. Select the parameter you want to restrict. The two histograms in the lower part will
show the distribution of this parameter. The right histogram of all spots, the left
histograms only for the spots that passed the thresholding. These histograms are
shown for the detected spots in the currently selected cell.

b. Define the boundary for the upper and lower threshold. This can be done by either
moving the slider or changing the values in the text field. The red vertical lines move
accordingly and indicate the current value of the thresholds.

c. Press ‘Apply threshold’ to make this selection active.

d. Enable ‘Lock values’ to make this selection permanent. Now you could set additional
thresholds with other parameters. Pressing ‘Unlock all’ will remove all defined

thresholds
Example: 7. Thresholding
Thresholds for sigma-xy are set to: a soma-xv o M L 2| 126

.. . Max o » 290
minimum of 126 and a maximum of 290. < B E—

Apply threshold M Lock values Unlock all
The threshold values are also locked.
Minimum allowed distance between mRNA 300

Selected # of spots: 83 0 Total # of spots:103

8
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Spots stemming from noise usually have a large sigma, and small amplitude. So
they can be relatively easily identified. The distribution of the sigma’s and the
amplitude for the real spots looks like a skewed Gaussian distribution, while the
values from noise are outliers to the left and the right of this distribution.

It is interesting to perform this analysis on individual cells but we found that the
histograms become more informative when they are plotted for all detected spots in all
cells. This can be done in the batch-processing interface (explained below). In this
interface the same controls are available to define thresholds on the estimated
parameters as described here - except that it is done for all detected spots in all cells at
the same time.

5. Inspect detected spots

The detected spots can then be inspected with the ‘Spot inspector’ by pressing on ‘Visualize
Spots’in the lower part of the interface.

In this interface the detected spots in each cell can be displayed. Spots that pass the
thresholding of the step before are shown in green, spots that fail in blue. There are various
general controls to change the way the image are displayed that are identical to what can be
done with the outline definer. Additionally, the user can display either the raw or the
filtered image.

The tool ‘Data cursor’ can be used to inspect the individual spots. After selecting it you have
to DOUBLE-CLICK on the spot you want to inspect. FISH-quant will then display the
estimated parameters of this spot (left side of the interface). On the right side of the
interface FISH-quant will then display maximum intensity projection (MIP) along the three

axis of the spot in the image (first column), and of the fit with the 3D Gaussian (right
column).
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6. Save results of spot detection

Results can be saved in a text file from the menu [FQ] Main > Save > Detected spots. Save for
each spots all acquired information. Two options are available: either save all spots, or only
the spots that pass the thresholding. We usually choose the former since we can then adjust
the thresholding later if needed.

Example: the three files in the results folder ending with __outline_spots_130305 are such
files.

7. Save settings for batch processing

The final step is to save the specified detection setting for future reference and also to use
them in the batch-processing module. This can be down from the menu [FQ] Main > Save >
Detection settings. This will generate a text file containing the experimental parameters, and
the settings for filtering, pre-detection, and fitting.

‘ Example: see the file _FQ_settings_ MATURE.txt in the results_ mature sub-folder.

3.2. Mature mRNA detection in batch mode

If the detection settings are comparable for different cells, then the detection can be performed
automatically for all outlines files. Images have NOT to be filtered the filtering is done also in the
batch-processing. This means that the user has to provide outlines files for all images, determine
the settings, and then the processing can be done automatically.

This is done in the batch-processing module of FISH-quant. This module is also used for the
transcription site quantification, but here we will only focus on the relevant parts for the mature
mRNA detection.

1. Open batch processing module from the menu of the main interface [FQ] Main > Tools >
Batch processing. You can then also activate the parallel computing capability if this is
possible on your system.

2. Define folders as in the main interface. If the folders are already defined in the main
interface you can set the same folder for the batch-processing from the menu Folders > Use
Folders from FQ-main.

3. Load settings file (Panel ‘1. Define file with settings’) . Here you load the file that you save in
the preceding section

‘ Example: load the file _FQ_settings_ MATURE.txt in the results_mature sub-folder.
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4. Load the outline files to be processed (Panel ‘2. Outlines to be processed’). Here you can
multiple files - but they have to be in the same folder.

Example: select the three outline files from the outlines sub-folder.

Load analysis

FISH-QUANT

[FQ] Batch Folders Average spots Advanced Settings

v2a: batch mode

settings B [OPTIONALI Detect transcription sites
Load
oad settings After thresholding is
[ Parallel computing applied offect on
3 a & Intensity threshold ° ’
Define outline files 2. Outline files to be processed ™ different cells is
that should be 5. Quantify TxSites [nascent mRNAI displaved
processed. I e cell o isplayed.
AVG # spots per cell [total] 46 +/- 51 3 5.1 Settinas.
. BGH_CY3_02__outline.txt AVG # spots per cell [after threshold] 39 +/- 43 X .
Also select files here ECLCEABSctinans - Load settings tings NOT defir
to be'opened with Sgmaxy 5] Mn o T ‘ AMPs NOT defined
Spot inspector. Max | o 240 ‘ .
Apply threshold P —
g V! Lock values Unlock all
Minimum allowed distance between mRNA 600 DRI Gy Threshold spots
r— — ‘ based on estimated
o 0 € parameters of fit.
Controls to Delete selected | Delete all
determine if filtering 50 150 (] save results (] Save figures (] Auto-save
should be performed 3. Process detect mature mRNAI ) Txste backgroung .
or not. y PROCESS |~/ save fitered images " o0
Restrict width (V! Use filtered images 20 50 5. [Optionall Restrict size
—— Max. radius [nm)] 1000
P e p—— ot _l Save resuts () Savefigures
Start batch-pro- L 163 || Amplitude 120 Show results of detection
cessing Sigma Z 526 Background 254 ‘ Show detected spots Spot inspector
5. The batch-processing will also perform the filtering if

i.  No filtered image is present

ii.  The option ‘Use filtered image’ is disabled.
Usually we don’t do the filtering for each image, but define only the outlines and the settings
and FISH-quant will then do the filtering automatically. This saves a lot of time since the
filtering can take a lot of time.
By enabling the option ‘Save filtered image’ the filtered image will be saved in the image
subfolder. FISH-quant will then also generated new outline files with a reference to these
images. When opening these files, FISH-quant will automatically open the filtered image as
well.
To separate these new outline files from the old ones, we make a new folder to save these
files. We then update the outline folder in the batch-processing to this folder. The new files
will then be saved in the new folder. This will not affect the files that are already defined in
step 4 above.

Example:

See subfolder outlines_batch. Contains the same outlines as the subfolder outlines, except
that there is a reference to the filtered images. These outlines also have the suffix _batch.

The filtered image are indicated with the suffix _filtered_batch.

Run analysis by pressing ‘Process’.

Depending on the number of files this can take between a few minutes to a few hours.
Updates are provided in the interface and the Matlab command window.

When the analysis is done two histograms will show up. As for the analysis of individual cells
they can be used to display the distribution of one of the parameters estimated for the
individual mRNA spots. However, here the histograms are populated with the values of all
spots from all cells. Usually it's much easier to define good threshold values. Same
considerations for the thresholding apply as mentioned above.
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Each time a threshold is updated, it will be applied to all cells. The effect on each image is
indicated in the status window where for each cell the number of mRNA spots before and
after the thresholding is shown.

The detection can also be verified in the images: select the outline you want to look at in the
list in panel 2. Then press on ‘Show detected spots’. This will open the spot inspector
window described above.

Example: we use the following min/max threshold for three parameters: sigma-xy:
117/240; sigma-z: 360/800; amplitude: 50/250.

Save results.

A number of different results files can be saved from the menu [FQ] Batch > Save. The results
will be save in the specified results folder.

i.  Settings [mature detection]: this will save the analysis settings. Especially interesting if
you change the detection thresholds.

ii. Results for each image: this saves a results file for each outline file that containing all
information about each detected spot in the cells defined in this outline. Two different
options are available: either all detected spots or only the spots that passed the final
thresholding. We usually use the former option since this way we can inspect all spots
and potentially adjust later the thresholding settings. Such a text file is generated
automatically for each outline file.

Example: the three files in the results folder ending with __outline_spots_130305 are such
files.

iii. Summary: mature mRNA. Generates one text file containing a summary of the number
of detected spots for each cell. The file lists the total number of detected spots, the
number of spots that passed the threshold, and (if defined) the number of spots in the
nucleus.

Example: see the file __FQ_batch_summary MATURE_130305.txt in the results_mature
subfolder.
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4. Nascent mRNA counting

FISH-quant also allows quantifying the number of nascent transcripts at the transcription site
(TS). FISH-quant compares the signal of the TS to the typical signal of mature mRNAs and infers
the number of equivalent full-length transcripts at the TS, i.e. how many mature transcripts
would give the same signal as observed at the TS.

This analysis requires that the signal of the individual mRNA is well defined, we therefore
use the results of all detected spots in all cells. This usually gives several thousand
individual mRNA’s that are considered in the analysis. With fewer spots not all methods
might work reliably.

Several different methods are implemented. The first two methods consider the spatial extent of
the transcription sites and are the method of choice.

i. Integrated intensity. Here the TS is also fit with a 3D Gaussian and the integrated
intensity under the curve is compared to the integrated intensity for the mature mRNAs.
This approach should work for most transcription sites. It starts to fail only for
elongated, ellipsoidal sites.

ii.  PSF superposition approach. Here the image of the TS reconstructed. In and iterative
process the image of an individual mRNA are placed one of the other until the best
description of the TS is obtained. Might be sensitive if the image of the mRNA is noisy
because an insufficient amount of mRNAs have been considered.

The two other methods ignore the spatial extent, and work for very small TS that are not much
larger than individual transcripts (see also the Nature methods paper describing FISH-quant for
more details).

iii. =~ Amplitude. TS is fit with 3D Gaussian and the estimated amplitude is compared to the
amplitude of the individual mRNAs.

iv. Maximum intensity. The intensity of the brightest voxel of the TS is compared to the
brightest voxel of the individual mRNAs.

The overall workflow is comparable to the mature mRNA quantification. First, the settings
are defined for one example. Then all outline files are processed in the batch-processing module.

4.1. How to obtain the necessary files for the quantification

To perform the TS quantification information about the individual mRNAs is necessary. This is
usually obtained in the batch-interface after the mature mRNA quantification is finished (as
described above).

Alternatively the results can be loaded into the batch interface [FQ] Batch > Load > Results of spot
detection. Here the results files for each image can be loaded into the batch-interface.

Example: load the three files in the subfolder results mature ending with
__outline_spots_130305. This will automatically also load the associated settings file.

Two files are necessary.
1. Save summary file of all detected spots.

This file contains a list with all detected spots and their parameters, e.g. amplitude and
maximum intensities. This file can be generated from the menu [FQ] Batch > Save > Summary
of THRESHOLDED spots. It is important to select THRESHOLDED and not ALL to save this file,
since in the downstream analysis we only want to consider spots that are really mRNA.
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Example: see file __ FQ_MATURE_SUMMARY_ALL spots.txt in the subfolder results_nascent. It
contains the detection results of 7.5K individual mRNA molecules.

2. Average images of mRNA.

This image is obtained by averaging the images of all individual mRNA molecules together. It
will then be used to determine the integrated intensity and it will also be used in the PSF
superposition approach.

To average all mRNA images together go the menu item Average spots > Average all
thresholded spots. Then a dialog box will open with some parameters describing the
averaging (for this example simply confirm. The most important parameter to change is
usually the size of the cropping region in z - too large values will lead to a rejection of a lot of
spots because they are too close to the edge of the image. for more information consult the
user manual.). Then all spots will be averaged. When the averaging is finished, a window will
be displayed that shows the averaged image as a maximum intensity projection along the
different axis (see below). This image is still quite noisy since only a few hundred spots are
averaged together. The quality will improve if more spots are considered.

800 Figure 1
File Edit View Insert Tools Desktop Window Help
~ ide B RO @ 0&

Avg.edspot-X2 Avg.edspot-YZ

Avg.edspot-XY

The image can then be saved as a TIF file from the menu Average spots > Save as TIF >
Normal sampling.

Example: see image _mRNA_AVG_ns.tif in the subfolder results_nascent. This image was
obtained by averaging the image of 6K individual mRNA molecules.

4.2. Setting up transcription site quantification

Here the settings for the transcription site quantification are defined. Start from the main
interface with an outline file opened, e.g. the outline file for BGH_CY3_03.tif.

1. Change results folder in the main interface to a new folder containing the results of the TS
quantification, e.g. results_nascent.

2. Open transcription site module.
From menu in main interface Tools > TxSite quantification.

3. Import averaged image of mRNA molecules.
Press button ‘Image of mRNA’. Here you load the average image of the mRNAs.

Example: define image _mRNA_AVG_ns.tif in the subfolder results_nascent.

4. Define settings
Press button ‘Parameters’. Simply confirm since default parameters are ok. Consult manual
for a more detailed explanation.

5. Define background of image of mRNA molecules.
Here the background of the average image of mRNA molecules has to be specified. Can be
either a background image or a single scalar value that is subtracted. Usually we use a single
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scalar value that can be measured at the edge of the image. Consult user manual for a more
detailed description and for instructions how to perform this measurement.

Note: this is only important if the PSF superposition approach will be used.

Example: select scalar and define a value of 243 for the background.

6. Define estimated amplitude of mRNA molecules.
Here the results for all detected spots have to be specified. FISH-quant will then extract the
relevant parameters for the TS quantification. Here either the detection results from the
main interface can be used (if present) or a results file can be loaded (such as the one
mentioned at the beginning of this section). FISH-quant also either considers the distribution
of the estimated amplitudes or simply their mean value. If a large number of mRNAs have
been analyzed we use their distribution, otherwise the mean value.

Example: Select ‘File’; choose __FQ_MATURE_SUMMARY_ALL_spots.txt from the subfolder
results_nascent; select ‘Distribution’.

7. Process settings.
Press button ‘Analyze settings’ to pre-process these parameters. This will take a few
moments - progress updates are provided in the Matlab command window.

8. Perform quantification.
Then the TS quantification can be tested either on the currently selected TS (by pressing
‘Selected site’) or on all TS in the image (by pressing ‘All sites’).

By default the PSF superposition approach is not applied. It is computationally more
intensive than the integrated intensity approach, and for most cases not necessary since the
integrated intensity approach works fine. But it can be enabled with the respective toggle
button.

The TS quantification also supports parallel computing on suitable systems. This option can
also be enabled with the respective toggle button.

Example: quantify the TS in Cell_1 (called TxS_auto_2) by first selecting it, then enabling
‘Use also PSF superposition approach’, and finally pressing ‘Selected site’. Will give the
following results (as displayed in the Matlab command window. Here the estimated number
of nascent mRNA at the TS with the different methods are listed

==== SUMMARY OF TxXSITE QUANTIFICATION ====

All REC: mean +/- stdev 46 +/- 2
Best 10% of REC: mean +/- stdev : 48 +/- 3

Number of mRNA at TS (ratio integrated INT): 42

(
Number of mRNA at TS (sum of pixel) . 30
Number of mRNA at TS (ratio max. int. ) : 20
Number of mRNA at TS (ratio fitted AMP) : 20

AVERAGED SIZE OF TRANSCRITPION SITE
All mRNA : 594 +/- 24 nm
mRNA within max distance : 594 +/- 24 nm

9. Save settings.
Then the settings can be save from [FQ] TxSite > Save settings. This will generate a text file
with the settings that can then be used in the batch processing-module.

Example: see file _FQ_settings NASCENT.txt in the subfolder results_nascent.

There are a number of other settings that can be changed for the TS quantification. However,
this is beyond the scope of this document, please consult the user manual for more details.
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4.3. Transcription site quantification in batch mode

1.

Start interface.

The TS quantification settings can now be applied in the batch-processing module. Load this
module as for the mature mRNA quantification. Set the correct folders. Load the mature
mRNA settings (necessary for the experimental parameters).

Then the outline files that are processed have to be specified. Here the best is to work after
the mature mRNA quantification is performed. This allows saving a summary file containing
the results of the mature and nascent mRNA quantification. This means that the TS
quantification is done either directly after the mRNA quantification is performed, or the
mRNA quantification results files are loaded in the interface as described above.

Example:
Steps 1-2 have only to be performed if the batch interface does not show the results of the
mature mRNA quantification.

i.  Setthe relevant folder structure to the example data.

ii. Load the three files in the subfolder results._ mature ending with __outline_spots_130305.

Load TS quantification settings
This is done with the button ‘Load settings’ in the panel ‘5. Quantify TxSites [nascent mRNA]’.

Example: load file _FQ_settings. NASCENT.txt in the subfolder results_nascent. |

Analyze settings: press button ‘Analyze settings’.
Will take again a few moments to perform the pre-analysis. Updates are provided in the
command window of Matlab.

Perform analysis: press ‘Quantify TxSite

You can again choose if you want to used the PSF superposition approach or not and if you
want to use the parallel computing option. There are a number of options that allow saving
some more detailed results about the quantification (we won’t use this here - see manual for
more details. Will quantify all TS in all cells.

Restrict size

This affects the PSF superposition approach. The size of the TS that will be considered in the
analysis can be restricted. Al mRNA that are outside of this radius (measured from the
center of mass of the TS) will not be considered as nascent transcripts. This helps to reduce
the effect of mRNA'’s that are placed outside the TS to describe background or individual
mRNA's that are within the measurement area.

Example: restrict size to 1000 nm.

Save results files.
Different results files can be saved from the menu [FQ-Batch] > Save.

Summary: nascent mRNA
Gives a detailed summary for each transcription site. Here the results of the different
quantifications together with the estimated size are saved.

Example: see file _ FQ_batch_summary_NASCENT_130306.txt in subfolder results_nascent.

Summary: nascent and mature mRNA

This option is available if the amount of mature mRNA has been quantified for each cell.
Then a summary file for each cell containing the amount of mature and nascent mRNA can
be generated. The user can decide which result of the nascent mRNA quantification will be
used in this file. This file is well suited as an input for subsequent kinetic modeling.

Example: see file _FQ_batch_summary ALL_130306.txt. The transcription site
quantification is based on the integrated intensity.
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